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BBepgeHune

[Iporpamma Adobe InDesign CS4 npumina Ha cmeny nporpamme Adobe InDesign
CS3 1 oTHOCHTCS K HOBOMY TOKOJIGHUIO MporpaMM BepcTkd. Bepcuu mporpamm
Adobe InDesign y GonblinHCTBa NONb30BaTeNel MO MpaBy 3aMEHSIOT MPOrpamMmMy
Adobe PageMaker, koTopyt0 MHOTHE TObl OHM MPUMEHSITH JUIsl BEPCTKH Macco-
BBIX MyOJMKaLWi, HAaUMHAs OT BUBUTHOW KapTOUKH M 3aKaH4YMBas OyKJieTaMH, KHH-
ramu, ra3eTaMM M XypHajiamd. MHorue onepauuy U GyHKuu nporpammbel Adobe
InDesign CS4 ananoruuHsl ¢yHKuMsAM mnporpammbl PageMaker, oqHako ecTb U
CYLIEeCTBEHHble OTIMYMA. [ 1aBHOE OTIHYMe — 3TO oOwMii (pelMOBBIH MOAXO/,
Kak Uil BEPCTKHM TEKCTa, TaK M I BEPCTKH TpadUKH, BO3SMOKHOCTD MPSIMOM Bep-
CTKU u300paxkeHuit nocneanux Bepcuit Adobe Photoshop u Adobe Illustrator, Tu-
MU3aLMs NleYaT U [BETO/CNIeHHs, a TakKe TUIIOBOE yNpaBJieHHe LIBETOBOCIPOU3-
BeieHueM B rpynne nporpamm Adobe Master Collection CS4, kyna Bxonut Adobe
InDesign CS4.

Hnrepdeiic Adobe InDesign CS4 cxox ¢ untepdeiicom Adobe Photoshop CS4 u
Adobe Illustrator CS4. OguHakoBbIf BUA W Ha3BaHUS MHOTHX MAJIUTP, UCTIONB30-
BaHWE MHOTHX OJIMHAKOBBIX WHCTPYMEHTOB, a TaKKe MPUEMOB CO3JIaHHs BEKTOp-
Hol rpaduku B Adobe Illustrator CS3 u Adobe Illustrator CS4 cyuectBeHHO 06-
JIer4aroT COBMECTHOE UCTONIb30BAHUE M U3YUCHHE STHUX MPOrPaMM.

KHura nocesiiieHa OCHOBHBIM, 0a30BbIM BO3MOXKHOCTSIM HOBOW BEPCHH MpOrpam-
Mbl Adobe InDesign CS4. BaxxHoit 0cOO€HHOCTBIO 3TOW KHUTH SIBJISETCS TO, YTO B
Heil MPUBOOUTCA HE TOJBKO JOCTATOYHO MOAPOOHOE OMMCaHHWE BCEX BO3MOYKHO-
cTeil mporpaMMbl, HO U MHOTOUYHCIIEHHbIE PUMEPbl KOHKPETHBIX THUITOBBIX OTepa-
LM, KOTOpbIE MPUXOAMUTCS BBIMOIHATH AU3aliHEPY M BEPCTANBIIMKY Ha MPaKTHKE.
KHura comepkuT Takke NMpUMEpbl CO3JaHHMS TaKWX MyOJIMKALMid, Kak BU3MTHAs
KapTouka, MH(pOpMaLMOHHAasi pekjiaMHas cTaTbs, Oykier. B Heit mpuBoasTcs Bce
orepaluy co3aaHus MyOavKalui, HauYMHas OT HACTPOMKHM MPOrpamMMbl, CO3AaHUs
HOBOTO JOKyMEHTa M 3aJaHHs ero rnapameTpoB, BEPCTKH TeKcTa M TpaduuecKux
n300pakeHNH 1 3aKaH4YMBasl BETOCIICHUEM U TeYaThlo.
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I'Iovlemy HanucaHa 3Ta KHUra

CoBpeMeHHOMY IM3aliHepy KOMMbBIOTEpHOH rpaduku, paboTaromemy B 00JacTH
nonurpadun nnn Web-au3aiiHa, MPUXOANUTCS MCIOIb30BaTh MHOTHE MpPOrpaMM-
Hble cpeacTBa. OHAKO eClii pedb UAET O MOATOTOBKE U300paskeHHi, TO AJis oOpa-
OOTKM MHKCEJIbHBIX HM300pakeHUil B OOJIBIIMHCTBE CIIydaeB KMCIOJIb3YETCs Mpo-
rpamma Adobe Photoshop Toii wiu uHol Bepcuu. DTa nporpaMMa yIAOBJIETBOPSET
OOJBIIMHCTBY TPEOOBAHMAM MMOJIb30BaTENIel U MPAKTUYECKH HE MMeeT KOHKYpeH-
ToB. [l 0OpaGoTKM ke BEKTOPHBIX W300pakeHMH HCIONMB3YIOTCS MPOrpaMMbl
Adobe Illustrator, CorelDRAW u Adobe FreeHand. [Ipuuem mo cBoum "xynoxe-
CTBEHHBIM" BO3MOKHOCTSIM 3TH MPOrpaMMbl HE CIMIIKOM OTJIHYAOTCS ApYr OT
apyra. Jpyrumu cioBamu, TO, 4TO MOYKHO C/ieaTh B OJHOM M3 HUX, BO3MOXHO U B
Ha3BaHHBIX JIPYTrUX. A MCMOJIB30BaHUE TOW WM WHOM MporpamMMbl Ha TMPaKTHKE B
HIepBYIO O4epeb ONpeessieTcs He TOJIBKO €e BO3MO)KHOCTSAMH, HO U Ha3HAYeHHEM
JNOKyMEHTa, TpaguLueii 01opo, Tae co3aaeTcsl TOKYMEHT U rae OyneT BhIMOJHATHCS
€ro LBETO/IeJIEHUE U Te4aTh, OMBITOM paboThl C MPOrpaMMOil 1 MHOTUMH JPYyTUMH
ncuxosnorudeckumu daxtopamu. Tak, CorelDRAW spnsercs "knaccukoil" cpeau
BEKTOPHBIX MporpamM. C Hee HAaUMHAIOCh M3yUYEeHHUE, UCTIONIb30BaHUE U TIpaKTHYe-
CKas pealu3alysi KOMIBIOTEPHBIX TeXHoJoruii B momurpaduu. UYro kacaercs
Adobe Illustrator, To 3Ta mporpamma IMPOKO WU3BECTHA, BCErla COCTABJIsIa KOH-
KypPEHLMIO APYTMM BEKTOPHBIM MpOrpamMMam, U ee CTaTyc B MOCJIeiHee BpeMs Cy-
IIECTBEHHO TOBBICWICS B CBsI3U ¢ pa3paboTkoii dhupmoit Adobe xommiekca mpo-
rpamm Adobe Master Collection CS4, Bxirovatoiero, noMmumo nporpamMmsl Adobe
InDesign CS4, nporpammy Adobe Photoshop CS4, a Takxe Adobe Illustrator CS4.

Tenepb nporpamMma BepCTKH, a TakkKe MporpaMmbl 00pabOTKH MUKCENbHBIX U BEK-
TOPHBIX M300paKeHU 00BbEIMHEHBI BO B3aUMOCBS3aHHBIA HA0OP, MO3BOJISHOUIMIA
KOMIUJIEKCHO BBITIOJIHUTh BCE JTambl co3laHus NyOnukauuidi. B HoByro Bepcuio
nporpammbel Adobe InDesign CS4 Bi/IIOYEHBI JOMOJIHUTENbHBIE MAaIUTPhl U
KOMaHIbl 00pabOTKM M300pa’KeHUH M TEKCTa, a TAKKe HOBblE BO3MOXKHOCTH CO-
BMECTHOI pabOThI ¢ APYTUMU POrpaMMaMH KOMILJIeKca.

KHura nomoxer Bam Jierko v ObICTPO OCBOMTb OCHOBHBIE MPHUEMbI PabOTHI ¢ MPO-
rpammoii Adobe InDesign CS4, u3yunts ee rpaduueckuii nHTEpdeiic 1 Ha3Haue-
HHE OCHOBHBIX YTNpPAaBJISIOUIMX DJIEMEHTOB. Bbl HayunTech co3laBaTh BEKTOPHBIE
WUTIOCTPALMK T MyOJIMKaurii, BBIMOIHATh UMIIOPT TEKCTAa M MHMKCENIBHBIX H30-
OpakeHMiIi W3 BHEUIHHMX NpOrpamm, coslaBaTh NpodeccHoHalbHblE OpUTHHA-
MakeTbl. MHOTOUMCIIeHHbIE YIpasKHEeHHs N0 paboTe ¢ TeKCTOM, TpaduKoil, a Takxke
M0 CO3JIaHHIO Pa3IMYHbIX 3PPEKTOB MOMOTYT BaM OCBOUTH MPOrpamMMy Ha Mpak-
THKE.



BeeneHnue 3

Ha Kkakom MaTtepuasne HanucaHa 3Ta KHUra
n KOMYy OHa apgpecoBaHa

OCHOBOW KHHI'M MOCIYXHWJIM OIBIT MpernojaBaHus, KOHCYJbTallMM W MHOTOYHMC-
JIeHHbIE METOJUYECKHE MaTepuabl Mo rpaduyeckum MmporpaMMam U MporpaMmam
BEPCTKHM, CO3JaHHbIE aBTOPOM sl oOydeHus ciywareneid B Cankr-IletepOypr-
CKOM roCyJapCTBEHHOM YHUBEpCHUTETe MH(POPMALIMOHHBIX TEXHOJIOTHH, MEXaHUKH
U ONTHKHK Ha Kadeape KOMMBbIOTEPHOTO MPOEKTUPOBAaHWS M Ou3aiiHa AkaaeMuu
MeToJ0B 1 TexHukH ynpaeieHus (JIMMTY) Ha npotsbokennn Gonee 9 net no crie-
uranbHocTH "KommnblotepHas rpaduka B nonurpadun u Web-auzaiin".

[TosTOoMy KHMra OpUEHTHUpPOBaHA B MEPBYIO OYEpe]b HAa UCIIOJIb30BaHUE ee JUIs ca-
MOCTOSTeNIbHON paboThl, MpU 00yUEHUH WM MOBBILIEHUH KBanUu(UKALUKA U Mepe-
MOArOTOBKE B 00JIACTH KOMMbIOTEpHOH rpaduku. Kpome Toro, ee MoryT mcrosib-
30BaTh CTYJEHTHI BBICIIMX U CPEJHUX YUEOHbBIX 3aBeJCHUN AM3alHEPCKUX HAIpaB-
JIEHUH A7 MPaKTHYECKOro W3y4YeHHWs MPOrpaMM BEPCTKH, a TaKKe BCE TE, KTO
XOYeT CaMOCTOSITEIbHO HAYUMThCS CO3AaBaTh MyOaMKALMKU U1 MOAUrpadruuecKo-
IO UCTIOJHEHHSI.

ABTOp HajieeTcsl, YTO, HE3aBUCUMO OT YPOBHS MOJATOTOBKY U 00beMa 3HAHWU, KHH-
ra nociay>KMT XOpPOLUUM MPaKTUUYECKUM MaTepyuagoM I LIUPOKOW ayaAuTOPUM Ha-
YHHAOIIMX TOJIb30BaTeNlel U MpodecCHOHANIOB, BCEX TeX, KTO XOUeT Ha MPaKTHKe
OBJIaZIETh UCKYCCTBOM CO3JIaHUSI MAKETOB MOJUTrpaduuecKOl MpoTyKIUH.

Yrto kacaercss W3NOXKEHHS MaTepuasa, TO aBTOP MCXOAMJ M3 TOrO, YTO YPOBEHb
NOATrOTOBJIEHHOCTH YMTaTeleld JIMTepaTypbl MO KOMMBIOTEpHO# rpaduke B TO-
clleflHee BpeMs CYLLECTBEHHO MOBBICHIICS. JTO OOBACHAETCS MHOIMMH MpUYMHA-
MH: TIOBBILICHHEM KOMITBIOTEpHU3alMK, BBIMTYCKOM OOJBIIOTO KOJMYECTBA KHHUT
Pa3IMYHOrO CONEpPXkKaHUS, HAJUYMEM Pa3MYHBbIX Y4eOHbIX 3aBEACHUH M KypcOoB
noBbIleHUs kBanudukauuu. [losToMy HeT He0OXOAMMOCTH MOAPOOHO M3JNarath
3JIeMEHTapHble CBEAECHHS O 3alycKe MNporpamMmbl, OMepauusX MO YIMpPaBJIEHUIO
KOMIBIOTEPOM, OCHOBHBIE MpHeMbl paboThl B onepalyoHHOi cucteme Windows.
XOTs B HECKOJIBKMX MEPBBIX IJ1aBaX 3TOMY YAEJeHO JOKHOe BHUMaHUe.

I[J'IH OCBOCHUSA MaTepurajia A0CTATOYHO 3HAHUA KOMIIbBIOTEpA Ha YPOBHC HAYHWHAIO-
o IOoJIb30BaTECJId.

KHury Mo)KHO pekoMeHI0BaTh Kak ydeOHoe nmocoOue i MpaKTHUECKUX 3aHATHH
10 KOMIIbIOTEPHOM BEPCTKE.

Kak NnoCTpoOeHa 3Ta KHUra

Temoii KHUTH SIBASIETCS M3ydeHHe BO3MOKHOCTeH mporpammbl Adobe InDesign
CS4. Knaura cocTOUT U3 TJiaB, B KOTOPBIX M3Y4arOTcs OCOOCHHOCTH WHTepdetica
NpOrpaMMbl, pPeaJiM30BaHHbIE B MPOrpaMMe LBETOBbIE MOJENH, MapamMeTpbl Ha-



4 BeeneHnue

cTpoliku. B Heli mogpoOHO MPUBOAATCS BO3MOXKHOCTH (POPMATUPOBAHUSI CUMBOJIOB
U ab3aleB TEeKCTa, CO3/laHHe BEKTOPHBIX OOBEKTOB MU KOHTYPOB, UX PeJaKTHPOBa-
Hue. bosplioe BHUMaHUe yleNeHO BEPCTKe TeKCTa U rpadku MHOrOCTPaHUYHBIX
nyOauKanuii, paboTte co cI0SMH U UMIIOPTUPOBAHHBIMHM MHKCETbHBIMU M300paske-
HusiMu. [IpuBOAMTCS omMcaHWe MCMOJIb30BAaHHUS CHUCTEMbl YIPaBJIEHUs LBETOBOC-
Npou3BeeHHEM, a TakKe MOATOTOBKM MyOJNMKAUMi K TeyaTH, LBETOJCNICHHS
UBETHBIX MyOiuvkauri u ux nedyat. OCHOBHasi 0COOEHHOCTb KHUTH COCTOMT B TOM,
YTO MO BCEM H3JIaraeéMbIM BOIIPOCAM MPHUBOASTCS MPAKTUUECKUE YIPAXKHEHUS, MO-
3BOJIAIOLIME M3YYHUTh MaTepuan Ha KOHKpETHBIX mpuMepax. Kpome Toro, onuchl-
BAIOTCS MPAKTUUECKME OMEPALMM MO CO3JaHUIO PeanbHbIX MyOJMKALMMA 1S MOoNu-
rpaduueckoi nevaru.

O6 aBTOpE

Jleskorer; Jleonnn bopucosuu, mpodeccop Cankr-IlerepOyprekoro rocymapcer-
BEHHOTO YHUBEpCUTETa MH()OPMALIMOHHBIX TEXHOJIOTWI, MEXaHUKW W ONTHKHU Ka-
(denpbl KOMMNBIOTEPHOTO MPOEKTUPOBAHMS W AU3aiiHa AKaJeMHUH METOJIOB M TeX-
uuku ynpaenenus (JIMMTY). KomnbroTepHoii rpadukoii 3anumaercs ¢ 1985 T.
[MpodeccuonanbHblii MpenonaBaTenb. 3a 3TO BpeMs MM pa3paboTaHbl ydeOHbIe
IJIaHbl U MHOTOYMCIICHHbIE METOAMYECKUE MaTepHabl Ul U3yUYeHHs TaKWX Ipo-
rpamMm, kak Adobe PageMaker, Adobe Photoshop u Adobe Illustrator. Ilo 3Tum
MarepuaiaM MpoLuIo 00y4YeHHEe HECKOJIBKO COTEH CilyluaTesieid, MHOrMe M3 KOTo-
PBIX ycrelHo paboTatoT B obsactu nonurpaduu u Web-auzaiina.

Agtop kuaur "Adobe InDesign CS3. bazossiii kypc. Ha mpumepax", "Adobe Photo-
shop CS3. bazoBwiii kypc. Ha mpumepax", "Adobe Photoshop CS3 Extended.
Camoe HeoOxoaumoe" U IIp., BbIMyLIEHHBbIX u3AarenbcTBoM "BXB-IlerepOypr"
B 2007 r.

Or n3partesibCcrtea

Bamu 3ameuanus, npeasoxkeHns: ¥ BONPOChI OTNPABJISITE MO aapecy 3JIeKTPOHHOR
noutsl m3narenbeTBa "BXB-IlerepOypr" mail@bhv.ru. Mer Oynem paasl y3HaTh
Balle MHeHue!

[TonpoGHyto wHpoOpManMIO 0 HAIIMX KHWTaX BbI Haimere Ha Web-caiite u3na-
TeJbcTBa www.bhv.ru.
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UHTepdeinc InDesign CS4

< Cucremubie TpeOOBaHHUS

< 3amyck u uHTEpdeiic mporpaMmmbl

< Opranusaius pabouyero Mecrta

< Co3pnanue HOBOTo JOKyMEHTa

< OTKpbITHE TOKYMEHTa

< Pasmeluenue naaurp

< Turbl 00bEKTOB B JOKYMEHTE

< Ucnone3oBaHue waba0HOB 1OKYMEHTa
< Tlanutpa UHCTPYMEHTOB

o llepemeleHue Mo NOKyMEHTY

[Iporpamma Adobe InDesign CS4 opueHTHpOBaHa Ha MCIIONB30BaHKE Mpodeccro-
HAJIbHBIMM BEepCTANIbLIMKAMU, AW3aiiHepaMu W XyJOXKHHKaMHu, paboTaloluMu B
W3aTeNIbCTBAX, PEKJIAMHBIX areHTCTBaX M (UpMax, 3aHUMAIOLUXCSl MOJrOTOBKOM
K MeyaTH 1 LBETOIeJIeHHIO NevyaTHoU npoaykuuu. [Iporpamma npegHasHaueHa s
BEPCTKHU MOJAUrpadriIecKrux U3AaHUM pazauuHbX TUIOB. OHA MO3BOJISET pacnosia-
raTte Ha CTpaHULE AOKYMEHTa B TpeOyeMoi MmociiefnoBaTebHOCTH TEKCTOBbIE O10-
KU ¥ rpaduueckre n300paeHus.

[Iporpamma Adobe InDesign CS4 mo3BosisieT BRIIOTHIATh UMIIOPT TeKCTa U rpadu-
4eCcKMX M300pakeHHH M3 Ipyrux nporpamm. Co3paHHBIM MakeT MOXKHO Hamedva-
TaTh, BBIMOJIHUTH €r0 LBETOJEJICHHE, COXPaHWTh Ul Tepenayd B ApPYrue mnpo-
rpamMMbl WM NiepeaTh B DJIEKTPOHHBIM Bue 3aka3zuuky. Adobe InDesign CS4 xo-
pOLIO COBMECTMMa C MpOrpaMMamMH TMHKCENbHOW rpadukd U BEPCTKU (QUPMBI
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Adobe, Takumu kak Adobe Photoshop CS4, Adobe Illustrator CS4, 6onee paHHuMHU
BEPCHUSMH STHX MPOrpamMm, a TakkKe ¢ IPyruMH rpaduueckiMH nporpaMmmamMu. JTo
IMO3BOJISIET BBITIOJIHATH BECh HpOCKT B CXOXKHUX nporpaMMax, 4qTO Cy[ﬂeCTBeHHO yC-
KOpSIET €ro co3aHue, 00ecreunBaeT BEICOKOE KAYeCTBO W HA/IE)KHOCTb.

Hnrepdeiic Adobe InDesign CS4 no BHewrHeMy BUIY MOX0XK Ha UHTepdeich Ipy-
rux nporpamm Adobe Master Collection CS4, Takux kak Adobe Photoshop CS4,
Adobe Illustrator CS4 u apyrux nporpamm 3Toii cepuun. MHTepdelic Bkimoyaer Ta-
KM€ THIOBbIE SJIEMEHTHI, KaK MEHIO, TTaHeJIb UHCTPYMEHTOB, MaJIMTPbI, AUAJIOTOBbIE
OKHa. Bce naeHTHYHBIE MM TOXO0XKHE KOMaHIbl y MPOrpaMM 3TOM TPyMIbl HaXo-
JSTCS B OJHMX W TeX K€ MEHIO M UMEIOT OJIMHAKOBbIC KJIaBUATYpHbIC KBHBAJICH-
Thl. BHelHee cxoncTtBo uHTepdeiica aenaer yaoOHOW mapauieibHyl paboTy ¢
NPUIOKEHUSIMHU U TIO3BOJISET OBICTPO OCBOMTH paboTy B MporpamMmMe.

CucteMHbie TpeboBaHuA

[Iporpamma Adobe InDesign CS4 Bxomut B HOBBIH Habop mporpamMm (hUpMBI
Adobe non HazBanuem Adobe Master Collection CS4. B stoT Habop BXonasaT Takve
nporpammbl, kak Adobe Photoshop CS4, Adobe Illustrator CS4 u np. B nokymeH-
TallMu K Habopy MporpaMM MPUBOAMTCS CIEAYIOIUI NepeueHb TPeOOBaHMI K ari-
napaTHbIM M TMPOrpaMMHBIM cpencTBam s |IBM-COBMECTHMBIX KOMITLIOTEPOB
C OIepalMoOHHON CHCTEMOM Windows®:

¢ nporeccop Intel Pentium 4, Intel Centrino, Xeon uinu IByXbsAAepHBIN MpoLec-
cop Intel ¢ wacrotoii 1,8 [Ty u BblILLIE;

¢ omnepaunonHas cuctema Microsoft Windows XP ¢ ycranoskoii Service Pack 3
wmn Windows Vista;

1 I'GaliT onepaTUBHOM NMaMSITH;
5 I'6aliT IMCKOBOTO MPOCTPAHCTBA [l YCTAHOBKH KOMIUIEKCA MPOrpamMM;
HakormTellb DVD-ROM;

* & & o

[[BETHOW MOHHUTOp c paspewmieHreM 1024x768, 16-OuTHbIN aganTep WM JTyd-
LLIUI;

rpadudeckas kapta He MmeHee 64 MOalT mamsTu;
PostScript”-npunrepsi: PostScript Level 2 uiu PostScript 3TM;

QuickTime 7.2 nyis ucnonp30BaHUS MyJIbTUMEIUHHBIX CPEJICTB;

* & & o

I/IHTepHeT HJIN Teﬂeq)OHHaSI CBA3b [JId aKTUBALIUW MTPpOrpaMMbl.

[Ipu ncnonp3oBanum nporpammel Adobe InDesign CS4 otnensHO crcTeMHBIE Tpe-
O0BaHMS HECKOIBKO CHIDKAIOTCS.
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Hosble BoamoxHocTn Adobe InDesign CS4

[Iporpamma Adobe InDesign CS4 cpaBautensHo "monogmas". PaccmaTtpuBaemas
Bepcusi umeer Homep 6.0. B kakayio HOBYIO BEpPCHIO MPOrpaMMbl BKJIHOYAOTCS
TMOJIE3HbIE TOMOJHUTENIbHbIE BO3MOXHOCTH. He sByiseTcs uCKIroUeHneM 1 3Ta Bep-
cusi mporpammbl. [IpuBeeM mnepeueHb OCHOBHBIX YJYYIIEHHH, JOOABIEHHBIX B
nporpammy.

L4
L4

H3meneH nntepdeiic mporpaMmsl, aHenel v NaguTp.

OTkpbiThie MyOJMKALMK MPUKPEIUISIOTCS B paboyeit 061acTu U 0TOOpaXkaroTesl
B BUJC€ BKJIaJOK.

C mporpaMMoii MOCTaBIAIOTCS BapyUaHThl pabounX MPOCTPAHCTB CO CTaHIAPT-
HBIMH HAacTpOMKaMu JIsl pa3fiMuHbIX BUIOB paboT. MMeeTcs BO3MOXKHOCTD CO3-
JaBaTh MOJIb30BaTeIbcKKe paboune NpoCTpaHCTBA.

Hoeas nmanutpa Preflight (Ilpenneuatnas npoBepka), mo3BoJstomas oOHapy-
JKUTDH Mpo0eMbl MyOJIMKALMK B pealTbHOM BPEMEHH.

Komannpl noBopota pa3zsopotoB MeHio View » Rotate Spread (Buz » [loBopot
Pa3BOpOTAa) MO3BOJISAIOT MOBEPHYTH pa3BopoT noa yriom 90° wiu 180°, uro cy-
LIECTBEHHO 00JIeryaeT roTOBUTh MyOJIMKAaUUK C aTbOOMHOM OpHeHTaLUeH.

HurennexryanpHble Hanpasisioure (Smart Guides), nosponsiougue Oosee
yI0OHO BhIPABHUBATh, TOBOPAYUBAThH WJIM MacIITAOUPOBaTh OOBEKTHI.

HutennextyanbHble pazmepsl (Smart Dimension), uHTesIeKTyallbHbIE TPOMe-
KyTkd (Smart Spacing) W uHTe/UIeKTyalbHble Kypcopbl (Smart Cursors),
npeAHa3HauYeHHble U1 YAOOHOro MO3MUMOHUPOBAaHUS OOBEKTOB B Mpolecce
BEPCTKHU.

Hogas yHuBepcanbHas nanurpa Links (CBsizu), mo3BosisioNias ynpasisTh CBs-
35IMH MaTepUasIoB MyOIHKaIIH.

HoBas naHesns npocMoTpa NMUKTOrpamMm cTpanull Ha nanurpe Pages (CtpaHulibi).

HoBble pa3mepbl CTpaHUL, NPU CO3JAAHUM WHTEPAKTUBHBIX JOKYMEHTOB MJIs
Flash u cTtpanun nokymenroo6opora ¢opmara PDF.

bricTpoe ynaneHue HanpapisiOUMX JMHUM C MOMOLLBIO KOHTEKCTHOTO MEHIO,
BbI3bIBAEMOTO LLETYKOM Ha FOPU3OHTAIIbHON WJIM BEPTUKAJIbHOM JIMHEUKE.

[Ipu ycTaHOBKE Havajla KOOPAMHAT Ha CepeIMHE Pa3BOPOTa 3HAYEHUSI KOOPAU-
HaT X AJi1 OpaBOil CTPaHULbI UMEIOT TMOJIOKUTEIbHbIE 3HAYEHHUS, a Jid JIEBOU
CTpPaHHULIbl — OTPULATEbHBIE 3HAUECHUS.

CornacoBaHue pa3mepa TeKCTa U MHTEPIMHbsSKA MPU UCTOJIb30BAHUM pa3iivy-
HBIX €IUHMLl U3MEPEHHs 3a CUeT YCTAaHOBKH MpHpAalleHHs CeTKH 0a30BBIX JU-
HUH B ITyHKTaXx.
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VYiydieHo UCHob30BaHUE 00JIaCTH "MpuUIlyck moja obopes3” u ciyxeOHOM 00-
nactu. Tak, Mpu nepeMeleHHH CTPaHULBI BMECTE C Hel MepemMenaroTes U 00b-
€KTbI, paCIlOJIO’JKEHHBIE B 3TUX O6ﬂaCTﬂX.

YCOBepH_IeHCTBOBaHa CHUCTEMA OTMCH onepauHﬁ MOJIb30BaTECJIA.

Brurodena HoBas manutpa Conditional Text (YcioBHBIH TEKCT), ¢ MOMOUIBIO
KOTOPOH MOKHO CO3/1aBaThb U COXPAHATHh B JIOKYMEHTE pPa3/IMuHbIe BapUAHTHI
TeKCTa.

COSILaHl/Ie H HUCIIOJIB30BAHUE MOJIb30BATCIIBCKUX cnosapei/'l.

BrutrodeHsl HACTPOWKM MHTEIIEKTYaJbHOTO 3aroyiHeHust Tekcta (Smart Text
Reflow).

VYnydiena pabota ¢ TabJUIiaMH.
ITossBunace BO3MOKHOCTD co3JaBaThb BJIOJKEHHBIC CTUJIU CTPOK.

JobapneHa CHMHXpOHM3aUMs AOKYMEHTOB B (paiijie KHUTM M CHUHXPOHM3ALMS
11a0JIOHHBIX CTPAHMLL.

PenaxkTtupoBath cBepcTaHHble M300pa’keHMsT MOXKHO Kak B IMporpaMme, ycra-
HOBJICHHOW MO YMOJIYaHHIO, TaK U B IPYTUX, BEIOPAHHBIX MPUIIOKEHHSX.

Viyuuiena pabora nepemellieHus rpadguyeckux (GpeliMoB, 3amoIHEHHBIX rpa-
¢buKoii.

Brurodena nmkimdeckas BcTaBka n3oOpakeHnid uz nporpammbel Adobe Illustra-
tor CS4.

VYnyumena pabota ¢ nanurpoii Pathfinder.
MO>KHO M3MEHSTh LBET, FPAJUEHTHYIO 3aJIMBKY, a Takxke 00BOJIKY TEKCTa.

VYcoeepuieHcTBoBaHa pabota ¢ uHcTpymMeHTOM Free Transform (CeoGoaHoe
TpaHcOpPMHUPOBAHHUE).

HM3meHunace BCTaBKa v pPE€AaKTUPOBAHHUE TPEAMETHOT' O YKa3aTeJIA.

JloGaBneHa Bo3MoxxHOCTB 3Kcnopra B popMat SWF u coznaHus TuHaMUUECKUX
nokymeHnToB juis Flash.

[Iporpamma WHTErpupoBaHa CO MHOTMMHU MporpamMMmamMu komiuiekca Adobe
Master Collection CS4.

VYiydiieHo 3yMUpOBaHUE CTPaHUI] JOKYMEHTA C MOMOIIbio nHeTpyMenTa Hand
(Pyka).

Bce 5TH HOBLIECTBA B TOM WM UHOU Mepe OMUCAHBI B KHUTE.
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3anyck n uHTepdoeiic nporpaMmmbl

[lpu m3yuyeHuM nporpamMMbl Mbl MpeANoaraeM, YTo Ha BalleM KOMIbIOTepe 3a-
rpy’keHa mporpaMMa B CTaHAapTHOM ycraHoBke. ClielyeT MMeTh B BHIY, YTO
Adobe InDesign CS4 no3BonseT W3MEHITb MHOTHE DJIEMEHTHI yrpasiieHus. Tak,
MO>KHO MPOW3BOJILHO MEHSTh YCTAHOBKHM MPOrpaMMbl M OpraHU30BaTh HabOp Kiia-
BUATYPHBIX COKPAIICHUH, OTJMYHBIX OT CTAHAAPTHBIX.

[Iporpamma Adobe InDesign CS4 comep>kuT Bce THITOBBIE SJIEMEHTHI HHTepdeiica,
CBOWCTBEHHBIE COBPEMEHHBIM MpOrpaMMam, padoTarOLMM MO/ YIPABIEHUEM OIle-
patmioHHoM cucteMbl Windows.

[Ipu 3amycke nporpammbl Ha 3KpaHe oToOpakaeTcs pUPMEHHas 3aCTaBKa, a 3aTeM
TUINIOBOE IMAIOrOBOE€ OKHO Havaja pabotsl (puc. 1.1), ¢ MOMOILBIO KOTOPOro MOX-
HO BBI3BaTh OMKMCAaHWE HOBBIX BO3MOXKHOCTEH MPOrpamMMBbl, a TAKKe OTKPBITH Cyllie-
CTBYIOLIMH TOKYMEHT, HJIM CO3/1aTh HOBBII JOKYMEHT, KHUTY MJIK OMOIHOTEKY.

Open a Recent Item Create New
B Jpen... ‘ Docurment
‘ Bioak:
‘ Library

9 From Template. ..

Community
= InDesign Exchange =
ﬁ InDesign User Group »»
ﬂ InDesign Partners »
& InDesign Plug-ins >»

l|:| Getting Started »» Adobe® InDesign® CS54
Find the latest tips, podoasts, and more in
u:] Mew Features »»

A clobe® Bridge Home,

l|:| Resources »»

|| Dar't show again

Puc. 1.1. lnanoroBoe okHO Hayana paboTbl

[Tocsie mpocMoOTpa HOBBIX BO3MOXKHOCTEH MpOorpaMMbl U BbIOOpa BapuaHTa CO3/1a-
Hus HOBOro AokymeHTa Create New » Document (Co3nats P JlokymeHT) U 3aaa-
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HUSI TapaMEeTPOB JOKYMEHTa Ha SKpaHe 0TOOpaXkaeTcsi OCHOBHOE OKHO MPOrpaMMbl
(puc. 1.2). DTo OKHO sBNSETCS HaYaJbHBIM 3JIEMEHTOM MHTepdeiica U comepKuT
Bce HEOOXOAMMBIE cpecTBa AJ1s1 paboThI MOJB30BATENS.

B ocHOBHOM OKHe MpHIIOKeHMs, Kak ¥ B OonbIMHCTBE Windows-npHiIoKeHHH,
HaXOATCS TUTIOBBIE 2JIeMEHThI MHTepdeiica. MHOTHe M3 HUX UICHTHYHBI I BCEX
nporpamm Adobe Master Collection CS4.

B m v P o= @ | Essenmas » [ (B ] -8 =

File Edit Layout Type Ohbject Table Wiew ‘Window Help

w[Eeset0s wi ) 1E =—cE |
L i Y.

Untitled-1 @ 70% x

=

’.‘"'.“rp1‘ o J s
@ Ey o o [—

3 [100%e e

o] -
=
k&,
B
& T
7 AN
[EE .
] 1 ,
H B 70 Links =2 AR GE
]| = Link Info <4 r
[ e =
RINERS
O Ll
a
ALy -
2 %‘ Br—0 %
| @7 M %
4 AT
md |ﬁ i %
7 =] [l K %
- [rswarcies I
] Iaj’ T T ] %
]
H [ [Paper]
1 | I [elsck] 7
] M [Registration] 2 & —
3 [ C=100 M=0 ¥=0 K=0 x
I =0 M=100 ¥=0 K=0 X LI
W =1 bl oNoemos b 08, 4] | » e o o §
#/ntyex| ) 01 - Microsoft word | ) 02 - Micrasoft word | & adobe Phatashap | ot |[ 8 adobe nDesign cs4 ... 0| [« & 1209

Puc. 1.2. OcHoBHoe okHO InDesign CS4

NMaHenb 6bicTpOro goctyna

B BepxHell yacTM OCHOBHOTO OKHAa pAacroJIOKEHA MaHeslb OBICTPOro JocTyma

(cM. puc. 1.2), conepkamasi ciaeayrolie KHOMKK BbI30BAa M HACTPOMKM 4acTo Hc-

TMOJTb3YEeMBIX OTIepaLHii:

¢ Go Bridge (3anmyck Bridge) — Bbi3piBaeT npuiioxenue Adobe Bridge
(Iucnietuep daiiso) ans paboTel ¢ daitiamu;

¢ Zoom Level (YpoBenp macmtaba) — ycTaHaBIMBaeT MaciuTad OTO-
OpaxkeHHst OTKPBITOrO U300paKeHUS;
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¢

E~] + View Options (ITapameTpbl MpocMoTpa) — MO3BOJISET OTOOPA3UTH B JI10-
KYMEHTE JOTOJHUTENbHbBIE DJIEMEHThI, TAKUE KaK IpaHHibl (peiiMa, THHEHKH
JOKYyMEHTA, HAaIlPaBIISOLINE JIMHUH, CETKY W CKPBIThIE CHMBOJIbI,

Screen Mode (PexxuM 5KpaHa) — COEPKUT KOMaH bl PEKUMOB SKPaHa;

Arrange Documents (YnopsgouvBaHue JIOKYMEHTOB) — MO3BOJISET
PAacIoNOXKUTh Ha SKpaHe TpeOyeMbIM 00pa3oM HECKOJIBKO OTKPBITHIX JOKYMEH-
ToB (puc. 1.3). PacnionoxxeHre 1OKYMEHTOB BBIMOJHSETCS C MOMOLIBIO KHOMOK,
Ha3Ha4Ye€HHEe KOTOPBIX MOHATHO U3 uX nukTorpamm. Komanaa Float All in Win-
dows (IlnaBatome okHa) pacmosiaraeT B paboyeil 00JIACTH OTKPBITBIE TOKY-
MeHTBI ¢ nepekpbiTieM, a koManaa New Window (HoBoe okHO) coznaeT ko-
MU0 TEKYLLEro JOKYMEHTa B OT/AEJIbHOM OKHe.

[C5M
m E m e
m S

LS | L e =

Float all in Windows
Tt Wfindow

Puc. 1.3. MNukTorpammel KHOMOK U KOMaHA bl
packpbiBatoLeiica kHonku Arrange Documents

MeHi0

OcHOBHOE KOMaHAHOE MEHIO MPOrpaMMbl COIEPIKUT CleAYIOLIUE MyHKThI:

¢

File (®aiin) — onepanuu c daitnamu. 31ech HAXONATCS KOMaHIBI CO3/IaHUS
HOBOTO (haiiyia, OTKPBITHUS OJTHOTO M3 MOCJEAHUX WM CyllecTByroulero (aiina,
3aKpBITHs, COXpaHeHHUs (aIIoB, pacrojoKeHHs B MyOJWKalWU TpaduuecKux
nu300pakeHUH, JKCMopTa MyOJIMKALMK, a TakKe H3MEHEHUs ee MapaMeTpOB.
Kpowme Toro, 3mecs nmeroTcst komaHbl 100aBieHuss MHGOPMALK O TOKyMEHTe
M €ro neyaTu;

Edit (IIpaBka) — komaHIBI OOIIEro peJakTUPOBaHUs JTOKyMEHTa (OTMEHBI U
BOCCTaHOBJICHUsI omepaiuu, padoTel ¢ OydepoM oOMeHa, BbIAEJICHHS! TEKCTa,
MOKWCKa W 3aMEHbl TEeKCTa, MpoBepka opdorpaduu, yrnpasieHHe MNpo3pay-
HOCTBIO, yIIpaBJIeHNEe [[BETOBOCTIPOM3BEACHUEM U YCTAHOBKH ITyOJIMKAIINHN );
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¢ Layout (Maker) — paboTta ¢ MakeToM myOaukauuu (yrnpasjieHHe CTpaHUuLaMu
Y HampapJsIOLIMMH JIMHUAMH, PElIaKTUPOBAHUE KOJIOHOK M CIIY>KEOHBIX dJie-
MEHTOB, KOMaH/1bl HABUTAI[UK 110 MyOJIMKaIMY, paboTa ¢ COJePKUMbIM TaOJIHIL);

¢ Type (Tekct) — pabota ¢ TekCTOM (Ha3HaueHUe mpudTa U pasMepa CUMBOJIOB,
napaMeTpbl mpudra u adbzana, pabora ¢ TabyIITOPaMH, UCIIOIb30BAHNE CTHIIEH
CHMBOJIOB U a03alleB, H3MEHEHHsI perucTpa, Mpeodpa3oBaHUe TEKCTa B KPHBBIE,
BCTaBKa ClicLilMaJIbHbIX CUMBOJIOB U OTO6pa)KeHI/Ie HerneyaracMbIX CI/IMBOJ'IOB);

4 Object (O6BEKT) — KOMaHIbl PabOTHI ¢ rpadUecKUMH O0bEKTaMH, KOHTYpa-
MU U ¢pelimaMu. BrimonHsoT TpaHchopMHUpOBaHHE OOBEKTOB, YNOPSAA04MBA-
HHe, BBIOOp, TPyNIUPOBaHUE M OTMEHA IPYNIHUPOBaHuUs, o0TekaHHe 00BEKTOB
TEKCTOM, yIpaBieHue (peiiMamu, JoOaBIeHHe TeHEeH, pacTylleBKa, M3MEeHEeHHe
YIJIOBBIX COWIEHEHUH, BAPUAHTbl OTOOPasKEHUs U JIp.;

¢ Table (Ta6bnuia) — pabota ¢ Tabnunamu (100aBIeHUE MYCTOM TaOIUILIBI, TTPe-
oOpa3oBaHMe TEKCTa B TaOJIMILy W, HAOOOPOT, TaOJIMIIbI B TEKCT, YCTAaHOBKA Ta-
paMeTpoB TaOJIMIIbI M €€ sueeK, H00aBIeHHe CTPOK W KOJOHOK, O0benHEHHE
s'YEEeK, PacIooKEeHHUE CTPOK);

¢ View (Bua) — npocmoTp myOnMKaumu U BbIBOX CIy»KEOHBIX 3JIEMEHTOB (Ipo-
CMOTP HAJIOKEHUsl, BIUSHUS MpPOQaiiyioB, MPOCMOTP LBETOMPOO, Ha3HAUYEHHUE
MaciuTaba W BapHaHTa OTOOpa)KeHHUs IMyOJIMKALUK U €€ CTPYKTYphI, BBIBOI H
CKpBITHE JINHEEK, HaNpaBJIsIOLINX, KOOPAWHATHOM CEeTKU U TpaHuLl (ppeiiMOoB);

¢ Window (OxHO) — ymnpaBieHHME OKHaMM AOKYMEHTOB (OTOOpaskeHHe AOKY-
MEHTa B HOBOM OKHe, YNOpsI0YMBaHHE OKOH JIOKyMEHTOB, CO3/1aHHe M COXpa-
HEeHUe HacTpoek uHTepdeiica, BbI30B U yJajleHUE C 3KpaHa MaluTp, OToOpaxe-
HHUE OTKPBITBHIX U TEKYLLETO JOKYMEHTOB);

¢ Help (Ilomouip) — omnuMcaHue mMporpaMMbl W MOMOLIb MO €€ MCIOIb30BAHHIO
(oMol MO NporpaMme U ee AOMOJIHEHUSM, CEePBUCHAs MMOJACPIKKA, aKTHBALS
Y perucTpauys nNporpamMmmai).

B IMYHKTaX MCEHKO HaXoAATCd KOMaHIbl, p€aIn3yrOIIHEC OONIBIIMHCTBO BO3MOXKHO-
crei nporpamMmmali. I[J'lﬂ BbI30OBa KOMaHIbI HGO6XO,HI/IMO AKTUBU3UPOBATH ITYHKT M€E-
HIO, a 3aTE€M UICJIKHYTb [0 UMEHH KOMaH/bI. le/l O9TOM MHOT'M€ KOMaHbI BbI3bIBa-
FOT AUAJIOTOBBIE OKHA, B KOTOPBIX CJICAYCT YKa3aTb Tp€6yeMbI€ napamMmeTpsl.

ManuTpbl

Baxnelimmumu sneMeHTaMu paboueil o6sacTy SBJISIOTCS NaIUTpbl. OTO HEOOJb-
[IMe OKHA, BbI3bIBaeMble Ajisi paboThl Mo Mepe HeobxoaumocTh. OOBIYHO clieBa
pacrnonaraetcst nanurpa UHCTpyMeHTOB Tools (MuctpymenTsl). OcTalibHble Ma-
JIUTPBI pacroiararoTcsi crpasa oT padodero okHa. s paboThl NaqUTpbl BbI3bIBA-
torcs u3 MeHio Window (OxHo). B ciydae ux HeHaJioOHOCTH, OHU CBOPAuYUBAIOTCS
710 3ar0JIOBKOB WJIM YOUpAOTCS C DKPaHa.
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Bce ocHOBHBIE KOMaHbl MEHIO U MAJIMTPbI MPOrPaMMbl MOAPOOHO OYAYT U3yUeHBI
B JaJIbHEUIIIEM.

Pa6bouune npoctpaHcTBa

Hacrpoiika Buna 0CHOBHOro 3KpaHa MOXET BBIMOJHSITHCS ¢ IOMOLIbIO Ha3HAUEHUS
Ui paboThl TaKk Ha3bIBaeMOro padodero nmpoctpaHcTsa. HactpanBaemelie pabouue
MPOCTpaHCTBa BbI3bIBatOTCS M3 MeH0O Window » Workspace (OxHo » Pabouee
npocTpaHcTBo) (puc. 1.4). Ilo ymon4aHuto ycTaHaBIuBaeTcs pabouee MpocTpaHCT-
Bo Essentials (OcHoBHOe), npeHa3HaYeHHOE JJIs BBIMIOJIHEHUs OOBIYHBIX Orepa-
uuii ¢ my6nukauuei. Jpyrue paboure npocTpaHCTBa BbI3BIBAIOT HA 3KPaH T€ UM
MHbIE MAJUTPbI, UCTIOIb3YEMbI€ NPH BBIMOJHEHUH HEOOXOAUMBIX AedcTBUid. OTMme-
TUM pabodee npoctpancTBo What's New (UTto HOBOro), npu Ha3HA4eHHWH KOTOPO-
ro B MEHIO IMOJICBEUMBAIOTCS HOBbIE M M3MEHEHHBbIE KOMaHbI, YTO 0COOEHHO TO-
JIE3HO IOJIB30BATENSAM, 3HAKOMBIM C MPEAbIAYLIEH BEPCUEH MPOrpamMMmBbl.

| Winciow | Help
Arrange 4 |
[Advanced]

. [Book]
P.sspnments v [Essentials]
sl [Getting Started]
Autamation -

[Interackivity]
v Color F& s )
[Printing and Proofing]
v Control Alk+Ctrl+6 [Typography]
EFFects_ Shift-+Ctrl+F10 [Wrhiat's New]
Extensions
Gradient Reset Essentials
Info Fa Tevs Workspace, .,
Interactive Delete Workspace,
> t:zrs £ Shiawy Eull renus
Cibject & Lavout 4
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AuanoroBble oKHa

JIONOMHUTENLHO K NaUTpaM B mpoliecce o0paboTku MyOIUKAMKA YacTO UCTIOJIb-
3YIOTCS JTMAJIOTOBbIE OKHA KOMAaH]I, JMAJOTOBbIE OKHA HACTPONKH MapaMeTpoB
(dhpeiimoB 1 MHorue apyrue. [ nponosmkeHus padoThl HEOOXOAUMO B BhI3BAHHOM
JIMAJIOTOBOM OKHE 3a/1aTh TpeOyemble napaMeTpbl U 0053aTeIbHO 3aKPbITh AHAJIO-
roBO€ OKHO.

Pa6ounin foKymeHT

OcHoBHOe MecTO B pabouell obnacTu 3aHuMaeT oOpabarbiBaeMasi MyONMKaLusl.
B otnuune ot apyrux rpadruecKuX NporpaMmM M TEKCTOBBIX peAakTopoB, B Adobe
InDesign CS4 npu co3gaHuKr HOBOro JOKYMEHTa YCTaHABJIMBAIOTCS MHOTHE Mapa-
MeTpbl MyOJMKaLMK U 334at0TCsl BApUaHThI ee 0ToOpakeHUs Ha skpaHe. Kak mpa-
BWJIO, MyOJMKauus co3naeTcs Ha 0a3e y>ke MOArOTOBICHHBIX TEKCTOBBIX OJIOKOB U
rpaduueckix M300pakeHHid, KOTOpble HEOOXOAUMO MPaBUIBHO Pa3MeCTUTh B J0-
kymeHTe. [ToaToMy 0ObIMHO BHauase co3aeTcsl MyCcToW JOKYMEHT, B KOTOPOM Bbl-
MOJTHSAETCS BEPCTKA M MOHTaXK TEKCTa U rpaduKH.

PaGoumii 1mOKyMeHT pacrojaraeTcss Ha MOHTaKHOM 00JlacTH, Ha3bIBaeMOM
Pasteboard (MoHTaxHas o0nactb). JTa 006JacTh UCMOJIB3YETCS AJISI BPEMEHHOTO
pa3MelleHrs] Ha Hel pa3fMuHbIX MaTepualioB MyONMKaLMKU Mepe] MX BEPCTKOM.
DneMeHTbI, pacrnonararoimuyecs B 3Toi 00J1acTH, He SBJISIOTCS YacThiO IMyOJIMKaLMA
M He BBIBOJITCS Ha Meyathb. Pa3Mep MOHTa)HOI 00J1acTH BBILIE M HIKE JTOKYMEHTa
M0 YMOJIYaHWIO YCTAHOBJIEH PaBHBIM 25,4 MM M MOXKeT OBbITh M3MEHEH B JHaio-
roBom okHe Edit » Preferences » Guides & Pasteboard (IIpaBka » YcraHoBku »
Hanpasnstouiye TMHUMA U MOHTa)KHAs 00J1acTh).

Pa6ouune matepuanbl

Jns nanpHeiinero u3y4eHWs MpOrpaMMbl BaM TOHAno0sATcs rpaduyueckue n3o-
OpaxkeHust 1 HaOpaHHBIE TeKCTHl. Mbl OyJeM MCIob30BaTh MHUKCENbHbIE M300pa-
JKeHHs, MoJAroToBieHHble B porpammax Adobe Photoshop CS4, u BekTopHbIE pu-
cyHku u3 nporpammbl Adobe Illustrator CS4, a Taroke TekcTbl, HAOpaHHbIE B MPO-
rpamme Microsoft Word. Bbl MoxkeTe ncnonb3oBaTh MOAXoAslIMe COOCTBEHHbIE
n300pakeHust U TeKcThl. KpoMe Toro, ¢ mporpamMMoii mocTaBistoTcsi MHOTHE 11al-
JOHBI myOsuKkatmi. [l co3maHns HOBOTO JOKYMEHTa OHM MOTYT ObITh BBI3BAaHbBI
komaHoit File » New » Document from Template (Daiin » Co3nare » JlokymeHT
no waboHy). Bel MoxkeTe MX MCTIONB30BaTh AJI1 MHOTHX YITPaXKHEHHUH.
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OpraHusauus pabouero mecrta

YMmenue paboTarh ¢ NpOrpaMMoi COCTOUT HE TOJIbKO B TOM, YTOOBI CO371aBaTh Ka-
YecTBeHHbIe MyOJMKALMK, HO M B ONTUMANbHOM OpraHuzaluu paboyeil obiacTy B
3aBUCUMOCTHU OT TGKyIJLGI’I CUTyaluu. TaK, AOBOJIBHO HaCTO MPUXOAUTCA YBEJINYU-
BaTh WJIM yMEHbIIaTh 00JacTh Ha dKpaHe, T/e BHINONHSETCS paboTa, yCTaHABIIU-
BaTh Tpebyembili MaciuTal, BBITIONHATH Pa3METKy CTpPaHUIlbl, U3MEHATb Haudayio
oTcyeTa KOOPAMHAT U T. [. DTO MOXKHO C/IeJlaTh HECKOJIBbKUMHU CIIOCO0aMH B 3aBU-
CHUMOCTH OT BbIIIOJHACMBIX 3a4a4.

PacnonoxxeHune oTKpbITbIX Ny6nnkauui

B paccmaTpuBaemoii Bepcur nmporpaMMel MpH OTKPBITHM HECKOJIBKUX MyOIHKaLMi
MX 3aroJIOBKM MPUCTHIKOBBIBAIOTCS B BUJE BKJIAJOK B BepXHel yacTu paboueid 00-
JJaCTU U He MMEIOT KHOTOK CBOpaYMBaHMs U pa3BopauMBaHus okHa (puc. 1.5).
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Pwuc. 1.5. PacnonoxeHnue B paboyein 06nactu AByX OTKPbITbIX NyGnunkauui

« § 1304

Jns akTMBM3alMK TOTO WJIM WHOTO OTKPBITOrO JOKYMEHTa HEOOXOIMMO BHITIOJN-
HUTH LIETYOK yKa3aTeleM Ha ero 3arojoBke. B ciyuae HeoOXOAMMOCTH OTKPBITHIH
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JOKYMEHT MOKHO PacroJIOKUTh B OTAEIbHOM okHe. [ aToro Heo6xoaumMo notsi-
HYTb JOKYMEHT BHHU3, 3aXBAaTHB 3a €0 3arojIoBOK. B 3TOM ciiyyae B 3arojloBKe OkK-
Ha JOKYyMEHTa OTOOpakatoTcs Bce CTaHIAPTHBbIC KHOIKH YNpPAaBJICHHUs €ro pa3me-
pom. OTaeneHHbIH OT 3aKperuieHUs HOKYMEHT MOXKET ObITh BOCCTAHOBJIEH Tepe-
MELLEHUEM ero 3aroJioBKa K BepXHel 4acTu padodeid 06aacTy.

MacwrabupoBaHue paboueit obnactu

31ech HY)KHO YTOUHHTB, YTO pedb HIET He 00 M3MEHEHUM pa3MepoB CO3JaHHBIX
00BEKTOB U TEKCTa, a O MaclTabe MX MpelCTaBleHHs Ha dKpaHe. YBEJIUUUTh WU
YMEHBUINTh OTOOpaKEHUE JNOKYMEHTa Ha 3KpaHe MpoLle BCEro, MCIojb3ys HWHCT-
pymeHT Zoom (Macmta0) . (IlpaBna, ecnu Bbl paboTaeTe MBIIIBIO C KOJIECH-
KOM, C/IeNaTh 3TO elle MpOLLEe, MPOKPYTHUB €ro B HY>KHYIO CTOPOHY TP YAep KaHUH
knaBuim <Alt>.)

H3yunmM mMaciuTaGupoBaHue Ha MpUMepe.

YMNPAXXHEHMUE 1.1

1. Ilocne 3amycka mporpammbl ¢ nomouisto komaHnbl File » New » Document
from Template (®aiin » Cozgats » JlokymeHT mo mabioHy) co3maiite JOKY-
MEHT TIOCPEJICTBOM OJHOTO W3 IabjJoHOB (Hanpumep, u3 nanku Flyers wmu
Brochures), mocraBnseMbIx ¢ mporpaMMoii.

2. Ha nmanenu nnctpymeHToB Tools (MHCTpyMEHTBI) akTUBU3UPYITE HHCTPYMEHT

Zoom (Macuira6) [} ]

( NMpumeuyaHne )

AKTMBM3NMPOBaTb — O3HAYaeT BbIOpPaTb WHCTPYMEHT WM cAenaTb €ero akTUBHbLIM.
[na aToro HeobXxoAMMO LUENKHYTb yKkasaTenem Mo 3HayKy MHCTpymeHTa. WHCTpy-
MEHT OCTaeTcs BbiOpaHHLIM 4O TOrO MOMEHTa, noka He ByaeT BblOpaH APYron UHCT-
PYMEHT.

3. Jns yBenudeHus macmitaba JokyMeHTa MHCTpyMeHToM Zoom (MacinTa0)
IIeJIKHUTE Ha cTpaHuie. Macmrald yBeTMuMTCS B J1Ba pasa, a 001acTh M300pa-
JKEHUSI, B KOTOPOH BBIMOJIHEH ILETYOK, OyIeT pacroloxkKeHa B IEHTPe SKpaHa.

4. Jlpyroit BapuaHT UCMOJIb30BaHUsl MHCTpyMeHTa Zoom (MaciuTal) — co3-
JaHWe WM BOKPYr 0O0JIaCTH MAacIITaOMPOBAHUS TPAMOYTOJbHOM INTPUXOBOM
paMKu. DTOT MPUEM KCIIOJB3YIOT B TOM Clly4ae, Korja HeoOX0oAuMO MaciTabu-
poBaTh KOHKpPETHYIO obOnacTh myOnukanuu. 3adukcupyiiTe Kypcop B Hadaib-
HOW TOYKE U, HE OTIMYCKAasi KHOMKY MBIIIH, NPOTSHUTE yKa3aresb 10 MPOTHBO-
TMOJIOXKHOM MO JIMaroHajiu TOYkW Oyayuiero BwifesieHus. OGnacTh, nomnasnias
B paMKy, OTOOpa3UTCs Ha SKpaHe B YBEJIMYEHHOM MacliTade.

5. Veenuubte uHcTpyMeHTOM Zoom (Maciurtad) C UCIIOJIb30BAHUEM LUITPUXO-
BOH paMKH MpaBylO 4acTh JHOKyMeHTa. KoHe4HO, 3TO He 03HauyaeT, uYTo JpYyrue
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